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Romeo mini Control Board (ESP32-C3)

SKU:DFR1063 (https://raw.githubusercontent.com/espressif/arduino—esp32/gh-
pages/package_esp32_index.json)

Introduction

The Romeo mini robot controller is the ESP32 version of the Romeo BLE mini. It features an onboard
ESP32-C3 module, supporting Wi-Fi and Bluetooth 5 dual-mode communication, and has two channels of
1.7A motor drivers.

Romeo mini has 9 10 interfaces (supporting analog, digital, UART, and 12C), with each interface compatible
with the Gravity standard. It can be connected to various Gravity sensor modules. The servo interface can
provide stable power supply through the servo power port for servos and other high-current devices.
Additionally, it has a built-in GDI interface on the back for connecting an IPS display screen to show project-
related information. The controller can meet the control requirements for robot motors and servos.

Features

Main control + WiFi + Bluetooth 5 integrated motor driver development board

Compact size

Support for IPS TFT display screen

Offers options for servo and motor control schemes
Specification

Basic Parameters:
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e Main control chip: ESP32-C3-MINI-1
e Type-C input voltage: 5V
e VIN input voltage: 5-15V

Introduction e Motor output current: 1.7A continuous drive current per channel
Features e Servo input voltage: 5-12V
Specification * Module size: 47x38.5mm

Board Overview

Dimension Drawing Interface Pins:

Tutorial * Digital I/O: x4
Frequently Asked Anal 1/O: x3
Questions nalog l/0: x
More e UART: x1

e |2C: X1

e Motor: x2

e GDI: x1

* Type-C: x1
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Name Function Description

Power input for motor driver and controller: 5-15V. This port must be connected for M1/M2

VIN
motors to work.

Power input for digital ports: 5-12V. If using high-current peripherals with voltage higher
Servo than 5V on digital output port (VCC end), connect to this interface to avoid damaging the

Type-C USB port.

M1/M2

Two motor control ports:
Ports

M1: GPIO1 (direction control), GPIOO (PWM control)

M2: GPIO10 (direction control), GPIO2 (PWM control)
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Name

12C

A-3.3V-
GND

D-VCC-

GND

UART

RST

BOOT

Romeo mini Control Board (ESP32-C3)

Function Description

Standard 12C interface: SDA (8), SCL (9), VCC (3.3V), GND

Standard analog interface:

A (blue): analog ports 3, 4, 5
3.3V (red): power supply positive terminal

GND (black): power supply negative terminal

Standard digital interface:

D (green): digital ports 6, 7, 20, 21

VCC (red): power supply positive terminal (When the Servo port is not powered, VCC is
5V; when the Servo port is powered, VCC is the input power for the Servo port.)

GND (black): power supply negative terminal
RX (20), TX (21), VCC (5V), GND

Note: The UART interface shares two IO ports with servo ports, so UART cannot be used
when servos are used.

Controller reset button

Controller download button
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Dimension Drawing
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Tutorial

1. Arduino Environment Configuration

When using the ESP32-C3 development board for the first time, it is important to follow these steps:
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Romeo mini Control Board (ESP32-C3)
Note: If your computer fails to recognize the Romeo Mini module when connected via USB, please press
and hold the BOOT button, then press the RST button. Finally, release both the BOOT and RST buttons
simultaneously.

1.Add the JSON link to the IDE. 2.Download the core of the main controller. 3.Select the development board
and serial port. 4.0pen the sample program and upload it. 5.Familiarize yourself with the Serial Monitor.

 Arduino IDE Compilation Environment Configuration
e Configure the URL in the Arduino IDE.

e Open the Arduino IDE and click File -> Preferences, as shown in the figure below:

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3
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&) Blink | Arduino 1.8.0

i

File| Edit Sketch Tools Help
Mew Ctrl+M
Open... Ctrl+0
Open Recent
Sketchbook v
Examples 3
Close Crl+W econd, then off for one second, repeatedly
Save B rd LED wou can control. On the UMD, MEGA and ZERO
Save As..  Ctrl+Shift+5 | o yigi000 on pin & LED BUTLITIN is set to
NG R BV O ent of which board is used
i the on~board LED 1z commected to on youwr Arduino model,
Print Ll board at hitps://www. arduine. ce/en/Main/Froducts
Preferences Ctrl+Comma
public domain
Quit Ctrl+Q
13 modified & May 201
1 by Scott Fitzgerald
15
16 modified 2 Sep 2016
17 by Arturo Guadalupi
15
19 modified § Sep 2016
20 by Colby Mewman
21
23
24 ff the setup function runs once when you press reset or power the board
25 woid setup () {
26 ff initislize digital pin LED_BUTLTIN as an output.

pinMede (LED_EUTLTIN, OUTFUT);
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¢ In the new window, click the button indicated by the red circle in the figure below:

Settings Hetwork

Sketchbook location:

C:\Users\Fman\Document s\ Arduine Browse
Editor language: Englizh (English) W (requires restart of &rduine)

Editor font size: 19

Interface scale: [+] futematic (100 5 %  (requires restart of Arduine)

Theme: Default thems - (requires restart of Arduine)

Shew verhose output during: [ | cempilation [ |uplead

Compiler warmings: Hone w

[]Display line mumbers [«] Enable Code Folding

[«] Verify code after upload [JUse external editor

[«] Check for updates on startup [«] Save when verifying or uploading

[JUse accessibility features

Additional Boards Manager URLs: |2_dev_index. jsom, http://download. dfrobot. top/FireBeetle/packaze IFRobot_index. jsu:-n

C:\Users\Fman'\AppData'Local \ArduinelS\preferences. tut

0K Cancel

e Copy the following link address into the dialog box that appears:
https://raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json
(https:/[raw.githubusercontent.com/espressif/arduino-esp32/gh-pages/package_esp32_index.json)

¢ Note: If you have previously installed other environments, you can press Enter at the beginning or end
of the previous link and paste the above link on any line above or below it.
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&) Additional Boards Manager URLs x

Enter additional URLs, one for each row

Ihttps:ffraw.githubusercnntent.c:n:\m..fespressiffarduinn—esp:iz..-"gh—pagesfpackage e3p3i2 dev index.jsnnl
http://download.dfrobot. top/FireBeetle/package DFRobot index.json

Introduction
Features

Specification

Board Overview
Click for a list of unofficial boards support URLs

Dimension Drawing

0K Cancel
Tutorial
Frequently Asked * Click OK.
Questions ¢ Update the board.
More ¢ Open Tools -> Board -> Boards Manager..., as shown in the figure below:
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-

Blink | Arduine 1.8.0

w

L

V. 4
File Edit Sketcl{!Toola Heli!

Auto Format
Archive Sketch
Fix Encoding & Reload

Serial Monitor

Blink

Serial Plotter
Tuwrns on an

WIiFi101 Firmware Updater

(=

¢
Most Arduir

1t 15 attaqg

Port: "COM134"

the correct

If you want Get Board Info

the Technic ,
Programmer: "ArduinclSP.org”

This exampl| Burn Bootloader

rduine/Genuino Zero (Programming Port)”

Ctrl+T

Ctrl+Shift+M
Ctrl+Shift+L

-

2 A

A e Sl TTD-bits ARM Cortex-M0+) Boards

Arduino/Genuina Zero (Programming Port)

Arduino/Genuino Zero (Native USB Port)

modified & May 201

by Scott Fitzgerald

modified 2 Sep 2016

by Arturc Guadalupi

modified § Sep 2016
by Colby Newman

// the setup function runs ence when you press reset or power the board

void setup () {

I imiaialies dimibal mie TET BUTTITTN ee o-

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3

Arduino AVR Boards

Arduino Yin

Arduino/Genuine Uno

Arduino Duemilanove or Diecimila
Arduino Nano

Arduino/Genuine Mega or Mega 2580
Arduino Mega ADK

Arduino Leanardo

Arduino Leonardo ETH
Arduino/Genuine Micro

Arduino Esplora

Arduino Mini

Arduino Ethernet

Arduino Fio

e Boards Manager will autorr-i-e;;c-ically update the board, as shown in the figure below:

m
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-

@9 Boards Manager ﬁ

Type A1l Filter your search. ..

Arduino AVR Boards by Arduino version 1.6.17 INSTALLED T
Boards included in this package: il
Arduine Yan, Arduing/Genuine Uno, Arduine Uno WiFi, Arduine Diecimila, Arduine Nano, Arduine/Genuino Mega, Arduino =
MegaADE, Arduino Leonardo, Arduino Leonardo Ethernet, Arduine/Genuine Micro, Arduino Esplora, Arduino Mini, Arduino Ethernet,
Arduine Fio, Arduing BT, Arduine LilyPadUsSB, Arduineo Lilypad, Arduine Pro, Arduino ATMegalG, Arduine Robet Contrel, Arduineg N
Robot Motor, Arduine Gemma, Adafruit Circuit Playground, Arduino ¥an Mini, Arduino Industrial 101, Linino One,

Cnline help

Mare info

Arduino SAM Boards (32-bits ARM Cortex-M3) by Arduino

Boards included in this package:

Arduing Due,

Online help

Mare info

Arduino SAMD Boards (32-bits ARM Cortex-M0+) by Arduino version 1.6.2 INSTALLED

Boards included in this package:

Arduine/Genuine Zero, Arduino/Genuine MER1000, Arduine MERZero, Arduino MERFox1200, Arduine MO Pro, Arduine MO, Arduine
Tian, Adafruit Circuit Playground Express.

Cnline help i

| Dowrdoading platforms index. ..

e After the update is completed, you can type "esp32" in the input box at the top. Then, select "esp32"
when it appears and click Install (current version: 2.0.0):
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&) Boards Manager

Type All ~ | |ESP32

DFRobot ESPF32 Boards

by DFRobot version 0.2.1 INSTALLED
Boards included in this package:
FireBettle ESP22-E Borad.

More Info

{ espI2 )

by Espressif Systems

Boards included in this package:

ESP322 Dev Module, WEMOS LoLin22, WEMOS D1 MINI ESP32.
Maore Info

2.0.0

Close

¢ Wait for the progress bar to finish:

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3
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&) Boards Manager

Type ALl ESP32

DFRobot ESPF32 Boards

by DFRobot version 0.2.1 INSTALLED
Boards included in this package:
FireBettle ESP22-E Borad.

More Info

espI2

by Espressif Systems
Boards included in this package:

More Info

ESP32 Dev Module, WEMOS LolLin22, WEMOS D1 MINI ESP32.

Installing. ..

Verifving archive integrity. ..

Cancel

e After the installation is complete, the list will display the installed ESP32 board, as shown in the figure

below:
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&) Boards Manager

Type A1l { | |ESP32

DFRobot ESPF32 Boards

by DFRobot version 0.2.1 INSTALLED

Boards included in this package:

FireBettle ESP22-E Borad, FireBettle ESP22 Borad.
More Info

espI2

by Espressif Systems version 2.0.0 INSTALLED

Boards included in this package:
ESP322 Dev Module, WEMOS LoLin22, WEMOS D1 MINI ESP32.
More Info

Select version Install

Remove

Close

¢ Click Tools -> Board:, and select "ESP32C3 Dev Module" (usually the first one in the list).

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3
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&) LED PWM | Arduinc 1.8.13

File Edit Sketch Tools Help
Auto Format Ctrl+T
Archive Sketch

ESP32C3 Dev Maodule |

LED_PWH Fix Encoding & Reload
18 /* Manage Libraries... Ctrl+Shift+1
2 x LE Serial Monitor Ctrl+Shift+M
3 . Serial Plotter Ctrl+5Shift+L
4 const WiFi101 / WiFiININA Firmware Updater foﬁj : |;| A rJ:u
5 | Board: "Arduino Yun® E Boards Manager...
e // LﬁE Port: "COM17 (ESP32C3 Dev Module)” 3 Arduino AVR Boards
7 const| GetBoardinfo DFRobot ESP32 Arduino
8 const Programmer: "AVRISP mkll" 3 ]
9 const Burn Bootloader
10

118void setup(){

12 //PaMBEE

13 ledcSetup (ledChannel,
14

15 //FE RS S maE A e B4 aEiE

le ledcAttachPin (ledPin, ledChannel);

freq, resolution);

17 '}

18

198void loop(){

20 / /BB AR

218 for(int dutyCycle = 0; dutyCycle <= 255; dutyCycle++
22 // changing the LED brightness with PWM

23 ledcWrite (ledChannel, dutyCycle);

24 delay(15);

25 }

e

L o S o o o e

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3

ESP3252 Dev Module

ESP32 Dev Module

ESP32 Wrover Module

ESP32 PICO-D4

ESP3252 Mative USB

ESP32 Wrover Kit (all versions)
UM TinyPICO

UM FeatherS2

UM FeatherS2 Meo

UM TinyS2

5.0D1 Ultra w1

micraS2

MagicBit

Turta loT Mode

TTGO LoRa32-0OLED V1

TTGO T1

TTGO T7 V1.3 Mini32

TTGO T7 V1.4 Mini32

¥inaBox CW02

SparkFun ESP32 Thing
SparkFun ESP32 Thing Plus
SparkFun ESP32-52 Thing Plus
SparkFun ESP32 MicroMod
SparkFun LoRa Gateway 1-Channel
u-blox MINA-W10 series (ESP32)
Widora AIR

Electronic SweetPeas - ESP320
Mano32

LOLIN D32

LOLIN D32 PRO

WEMOS LOLIN32

WEMOS LOLIN32 Lite

descrip
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T e N R A

e Prior to getting started, you'll need to configure the following settings (if you wish to print to the
Arduino monitor via USB, choose "Enable"):
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Romeo mini Control Board (ESP32-C3)

LED_PWM

@ LED PWM | Arduino 1.8.13
it & TE T8 EH

[Shiii=mm s
TEFE
EIFREH AT
AL
sNeERE

WiFi101 / WiFIMINA Firmware Updater

FTEtR: "ESP32C3 Dev Module”
Upload Speed: "221600"

USB COC On Boot: "Enabled” |

Upload Mode: "UARTD"

CPU Frequency: "160MHz (WiFi)"
Flash Frequency: "40MHz"

Flash Mode: "QIO"

Flash Size: "4MBE (32Mb)"

Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)"

Core Debug Level: "7"
#[0: "COM17 (ESP32C3 Dev Module)®
BEFEREE

iz
EESISER

Ctrl+T

Ctrl+Shift+1
Ctrl+Shift+M
Ctrl+Shift+L

Disabled
Enabled

o o W W W W w VWV L

for(int dutyCycle = 0; dutyCycle <= 255; dutyCycle++) {

// changing the LED brightness with PWM
ledcWrite (ledChannel, dutyCycle);

delay(15):

/ /B AN
for(int dutyCycle = 255; dutyCycle >= 0; dutyCycle—-) {

g (L
5

6 //WE
7 const
8 const
9 const
10
118void
12 //E
13 led
14

15 /1]
le led
17 '}

18

198 void
20 /]
218

22

23

24

25 }
26

277

2868

29

// changing the LED brightness with PWM

L
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Introduction

¢ Click on "Port" and select the corresponding serial port. (If the port keeps appearing and disappearing,
you need to press and hold the BOOT button, then press the RST button, and finally release both the
BOOT and RST buttons simultaneously).
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Romeo mini Control Board (ESP32-C3)

&) WiFiClient | Arduino 1.8.13
File Edit Sketch Tools Help

Auto Format

Archive Sketch

Fix Encoding & Reload
Manage Libraries...
Serial Monitor

Serial Plotter
WIFi101 / WiFININA Firmware Updater

Board: "ESP32C3 Dev Module”
Upload Speed: "921600"

USB CDC On Boot: "Disabled”
Upload Mode: "UARTO"

CPU Frequency: "160MHz (WiF)"
Flash Frequency: "B0MHz"

Flash Mode: "QIO"

Flash Size: "AMB (32Mb)"

Partition Scheme: "Default AMB with spiffs (1.2MB APP/1.5MB SPIFFS)"

Core Debug Level: "None”
Port: "COM17 (ESP32C3 Dev Module)”
Get Board Info

Programmer

Burn Bootloader

Ctrl+T

Ctrl+Shift+1
Ctrl+Shift+M
Ctrl+Shift+L

Serial ports
. COM17 (ESP32C3 Dev Module)

>

vold setup()

Serial.begin(115200);

WiFiClient
13 /%

2 * T
3 *

4 kY
5 % q
6 *

7 %

9 #incl
10

11 const
12 const
13

14 const
15 const
16 const
17

13

193 {

20

21

delay(10);

2. PWM-driven DC Motors

Requirements

DC Motors: x2
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¢ Romeo Mini: x1

Connection Diagram

Introduction The module is powered by 5-15V. Choose an appropriate power supply voltage based on the motors.

Features
Specification

Board Overview
Dimension Drawing
Tutorial

Frequently Asked
Questions

More

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3 21/32



2024/5/15 10:52

Introduction
Features
Specification
Board Overview
Dimension Drawing
Tutorial

Frequently Asked
Questions

More

Romeo mini Control Board (ESP32-C3)
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Control Modes
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Function
Forward
Reverse
Forward

Reverse

Romeo mini Control Board (ESP32-C3)
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Sample Code
int EN1 = @; // PWM control for motor M1
) int PH1 = 1; // Direction control for motor M1
Introduction int EN2 = 2; // PWM control for motor M2
Features int PH2 = 10; // Direction control for motor M2

Specification

Board Overview void setup() {

) ‘ . pinMode (EN1, OUTPUT);
Dimension Drawing pinMode (PH1, OUTPUT);
Tutorial pinMode (EN2, OUTPUT);
Frequently Asked pinMode(PH2, OUTPUT);
Questions h
More

void loop() {
M1_Forward(200); // Motor M1 moves forward with adjustable PWM
M2_Forward(200); // Motor M2 moves forward with adjustable PWM
delay(5000) ;
M1_Backward(200); // Motor M1 moves backward with adjustable PWM
M2_Backward(200); // Motor M2 moves backward with adjustable PWM
delay(5000) ;

void M1_Forward(int Speedl) // Forward fast decay mode for M1 motor, larger Speedl value resu

{
analogWrite(EN1, Speedl);
digitalWrite(PH1, LOW);

}

void M1_Backward

Example Result: Execute the sample program by commanding simultaneous rapid forward rotation of
motors M1 and M2, followed by simultaneous slow reverse rotation of motors M1 and M2.
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3. PWM-Driven Servo Motor

Prerequisites:

Introduction e 5V PWM servo motor x1

Features o
. . e Romeo mini x1
Specification

Board Overview . .
Connection Diagram:

Dimension Drawing

Tutorial If you need to operate a servo motor or peripheral device with a voltage higher than 5V, connect the Servon
Frequently Asked terminal to the power supply. The power supply range should be between 5-12V. The VCC terminal voltage
Questions is equal to the input voltage at the Servon terminal. When the Servon terminal is not connected, the default
More VCC terminal voltage is 5V.

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3 25/32



2024/5/15 10:52 Romeo mini Control Board (ESP32-C3)

Introduction
Features
Specification
Board Overview
Dimension Drawing
Tutorial

Frequently Asked
Questions

More

Vilop

ini

Romeo M

https://wiki.dfrobot.com/SKU_DFR1063_Romeo_mini_Control_Board_ESP32_C3 26/32



2024/5/15 10:52

Introduction
Features
Specification
Board Overview
Dimension Drawing
Tutorial

Frequently Asked
Questions

More

Romeo mini Control Board (ESP32-C3)

Sample Code

void setup() {

ledcSetup(0, 5000, 10); // Configure channel @ with a frequency of 5KHz and 10-bit resolution
ledcAttachPin(6, @); // Assign pin 6 as the output pin for channel @

¥

void loop() {

ledcWrite(@, 125); // Set the output of channel @ to 125, producing a PWM output of @ to 100%
delay(1000);

ledcWrite(@, 25);

delay(1000);

}

Example Result: Burn the sample program to cyclically rotate Servo 1in the range of 0-180°.

4. Driving an SPI Display

Prerequisites:
e 1.47" 172x320 IPS LCD Display Module (https://www.dfrobot.com/product-2638.html)
e Romeo mini x1

e The DFR0664, DFR0649, DFR0847, DFR0928, and DFR0995 models are all compatible with the
Romeo mini controller. For detailed usage instructions, please refer to the display's wiki page.

Connection Diagram:
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Sample Code

#include "DFRobot_GDL.h"
#define TFT_DC 8
#define TFT_CS 7
#define TFT_RST 9

DFRobot_ST7789_172x320_HW_SPI screen(/dc=/TFT_DC,/cs=/TFT_CS,/rst=/TFT_RST);
/* M@ mainboard DMA transfer x/
//DFRobot_ST7789_172x320_DMA_SPI screen(/dc=/TFT_DC,/cs=/TFT_CS,/rst=/TFT_RST);

void setup() {

screen.
screen.
screen.
screen.
screen.
.setTextColor(COLOR_RGB565_LIGHTGRAY); // Set the text color
screen.
.print("DF"); // Display the English characters

screen

screen

by

begin();

setTextSize(2);

fillScreen(COLOR_RGB565_BLACK); // Set the background color
setFont(&FreeMono24pt7b); // Set the font size (9, 12, 18, 24)
setCursor(/x=/32, /y=/200); // Set the text position

setTextWrap(true);

void loop() {
// Empty loop as no further actions are required for this example

}

Example Result: Burn the sample program to display the gray English characters "DF" on the screen.
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Frequently Asked Questions

Burn Error
Cause

e |f the delay in the loop is too short or no delay is added, it can result in a timeout error during the
burning process.
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* Incorrectly calling certain functions can cause the computer to not recognize the USB connection.

Introduction

L5 USB i8&
Features | RS EviEEms—~ USB iR
Specification :e’_EI_"f- FIEE, Windows FoiEiRSl
Board Overview PR s meamaE
Dimension Drawing
Tutorial Solution
Frequently Asked . .
Questions Press and hold the BOOT button, then click the RST button, and finally release the BOOT button.
More

No Serial Output
Solution

e Check if USB CDC is enabled.
¢ Use a different serial debugging tool to view the print information.

e For more questions and interesting applications, you can visit the forum for reference or to post your
queries.

More

e esp32-c3-mini-1 datasheet (https://www.espressif.com.cn/sites/default/files/[documentation/esp32-c3-
mini-1_datasheet_en.pdf)
e Motor driver chip drv8220 datasheet

(https://dfimg.dfrobot.com/5ea64bf6¢cf1d8c7738ad2881/wiki/0d792b7309275ae76bd61cbc548219d2.
pdf)
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e Schematic V1.0.0
(https://dfimg.dfrobot.com/5ea64bf6¢cf1d8c7738ad2881/wiki/1a43b798fa4191f577a9bc8fa17dc3dc.pd

f)
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